Adobe Premiere Rush CC Help
Legal notices

## Contents

### Chapter 1: Introduction to Premiere Rush
- What is Adobe Premiere Rush CC and how do I use it? ................................................................. 1
- Get to know the Rush interface ........................................................................................................ 6
- Keyboard shortcuts ............................................................................................................................ 12
- Capture and edit videos on the go using the Rush iOS app .............................................................. 13
- Common questions ............................................................................................................................ 28
- Adobe Premiere Rush CC system requirements .............................................................................. 33

### Chapter 2: Import footage
- Import photos, video, and audio ........................................................................................................ 37

### Chapter 3: Edit video
- Edit your video in the timeline .......................................................................................................... 44
- Add and refine audio .......................................................................................................................... 47
- Adjust transitions, color, and other media properties ..................................................................... 55
- Add and edit titles ............................................................................................................................. 62
- Jazz up your titles using professionally designed Motion Graphics templates ............................. 70

### Chapter 4: Export video
- Share or export your video ................................................................................................................ 74
Chapter 1: Introduction to Premiere Rush

What is Adobe Premiere Rush CC and how do I use it?

Rush is an all-in-one video-creation tool that you can use to capture, edit, and share professional-looking videos quickly.

You can capture videos and images right from within the app or bring in your own media. You can then edit your clips in the timeline and add titles, audio, and transitions. Refine color and audio with easy-to-use controls. Finally, export your video and share it directly to various social channels such as YouTube or Facebook with a single click.

Move seamlessly across devices (mobile or desktop) and feel confident that you can pick up where you left off with automatic project syncing. With a consistent experience across desktop and mobile, the power of Rush is available wherever you go.

What can I create with Rush?

Rush is ideal for creating short-form videos (~20 minutes or less) with high-quality motion graphics, audio, and color that you can share online with your social media followers or friends. Create and share content for YouTube, Facebook, Instagram and more.

What do I need to know to start using Rush?

Before you can begin creating and sharing video in Rush, you need to have the right equipment. At the most basic level, you need:

- A computer, an iPhone, or iPad (see System requirements)
- Rush installed on your computer, iPhone, or iPad (Download Rush from here)

Rush has an intuitive and easy-to-use interface that allows you to create videos with minimal training required.

To get started, launch the product, and go through the one-minute interactive tutorial that walks you through the basics of editing your first video, covering all of the key steps and features in Rush that you need to create and share your video.

Additional help and tutorials are always available on Rush Learn & Support.
Workflow overview

In a nutshell, the workflow can be described in the following high-level steps:

- Capture footage or import your own media into Rush
- Edit and refine video
- Export and share video

Capture footage or import your own media into Rush

You can capture footage using any phone, DSLR, or mirrorless camera and bring the footage into Rush. Rush automatically separates the scenes for you into clips.

You can also bring in audio files saved on your phone, or use the Rush soundtracks that are available from within the product.

For more information on bringing footage into Rush and for information about supported file formats, see:

- Import photos, video, and audio
- Supported video and audio formats for import

When using Rush on an iOS device (such as as iPhone or iPad), you can use the capture experience built right into the product, which gives you access to more control if you need it and a seamless experience of bringing your captured media quickly into a project. You can then edit the video on your mobile device, or switch over to Rush on your desktop. Projects sync seamlessly between desktop and mobile devices, so you always have access to your recent project edits across your devices, anywhere.

For more information on using the Rush iOS app, see Capture and edit videos on the go using the Rush iOS app.

Edit and refine video

You can edit videos in Rush, and you have access to the same editing capabilities across your iOS and desktop devices.

After you have brought in your video clips, you can pick out the good parts, cut out the slow or boring parts, shuffle scenes around, and add audio and animated titles or motion graphics.
Edit clips on the timeline

Edit your video in the timeline

After bringing in your footage into your Rush project, you can continue to add more clips, such as additional videos, images, graphics, or music. You can split clips, move them around, or trim them in the timeline.

For more information, see Edit your video in the timeline.

Add and edit transitions

Add transitions between clips to smoothly move from one clip to another. Generally, you use a simple cut to move from shot to shot, but you can also transition between shots by phasing out one and phasing in another.

Rush provides a few transitions that you can apply to your clips to enhance your video. For more information, see Add and edit transitions.
Add and edit titles

Easily add text overlays and animated motion graphics to your videos, and customize things like font, font style (bold/italic/underline), font size, and color. Easily edit text, and move, scale, and rotate title and graphic templates directly on the Preview monitor.

Take advantage of the professionally designed built-in Motion Graphics templates and access hundreds more customizable animated titles, lower-thirds, transitions, and graphics from Adobe Stock right from within the app.

For more information, see:
- Add and edit titles
- Jazz up your titles using professionally designed Motion Graphics templates

Add audio clips or record voiceovers

Import music and audio clips into your Rush projects. Or, you can record voiceovers directly into your timeline.

Rush also comes with 10 royalty-free soundtracks that you can import and use in your video.

For more information, see Add and refine audio.
Introduction to Premiere Rush

Adjust color

Rush includes several color presets that you can easily apply to clips to give them a certain look and feel. Click on a color preset to apply it to your selected clip, and if you like you can tweak the intensity of the preset.

You can also use additional editing tools to refine color further.

For more information, see Adjust a clip's color.

Crop, scale, feather, and tweak opacity

You can transform your clips in multiple ways. You can position your clips, change their height, width, or opacity, and crop your clips using Rush's transform controls.

You can also feather (smooth or blur the edges of your video) your clip. Feathering is a great technique to spotlight the middle of the video frame, and focus the viewer's attention to that point.

For more information, see Adjust transitions, color, and other media properties.
Export and share video
After you have completed creating your video, you can save it on your computer or directly share it on social media channels such as YouTube, Facebook, Instagram, or Behance.

For more information, see Share or export your video.

Step up from Rush to Premiere Pro
Rush is compatible with Premiere Pro. As you continue building your video expertise, you can effortlessly switch to Premiere Pro for ultimate editing control. In Premiere Pro, you can take advantage of a greater variety of transitions and effects, more-powerful color-correction and audio tools, multicamera editing, and a universe of third-party plug-ins.

Continue refining your Rush videos by simply opening the Rush project file in Premiere Pro. For more information, see Open Premiere Rush projects in Premiere Pro.

Note:
Once a Rush project is opened in Premiere Pro, you cannot bring it back into Rush. This is because not all of the advanced editing controls in Premiere Pro are supported in Rush.

Get to know the Rush interface
Using Adobe Premiere Rush CC, you can arrange and edit clips to create and share great looking videos.

You can edit your videos using all the editing elements that Rush provides within the Edit workspace. After you finish editing, you can share your videos using the Share workspace.

Home Screen
When you launch Adobe Rush, you see a Home screen that gives you quick access to create a new project, view learning material, tutorials, and interact with the Rush YouTube community. It also gives you easy access to all of your projects.
Home Screen

- **Create a New Project**: Get started with your new project by clicking this button.
- **Help**: Access Rush’s online help articles.
- **Learn**: Learn how to use Rush with online tutorials.
- **Community**: Join the Rush community on YouTube.

**The Rush Edit workspace overview**

The Rush Edit workspace is where you create your video, editing clips in the timeline and using the refinement tools. Customize your video by adding text, transitions, audio, color presets, and more.

**Note:**

All screenshots in the section have been taken on Mac. However, the Rush interface is similar on Windows operating systems and iPads. If you are using Rush on iPhone, see *Capture and edit videos on the go using the Rush iOS app.*
Adobe Rush Workspace


- **Home**: Takes you back to the Home screen where you can start a new project, and view or open all of your projects.
- **Edit**: Use the Edit workspace to edit your video - adding text, transitions, audio, color presets, and more.
- **Share**: Use the Share workspace to save your project or share it on YouTube, Facebook, Instagram, or Behance. For more information, see [Share or export your video](#).
- **Titles**: Choose from a collection of built-in Motion Graphics templates. For more information, see [Add and edit titles](#).
- **Transitions**: Add transitions like fade in, fade out, or dissolve. For more information, see [Add and edit transitions](#).
- **Colors**: Add a color preset or create your own by adjusting exposure, contrast, highlights, and more. For more information, see [Adjust a clip’s color](#).
- **Audio**: Adjust volume, mute, enhance voice, or auto duck background music. For more information on audio, see [Add and refine audio](#).
- **Transform**: Modify the appearance of your clip using crop, rotate, or scale, or do things like create a picture-in-picture effect. For more information, see [Crop and Rotate a Clip](#).
- **Control Tracks**: Toggle tracks on/off, hide tracks, or lock tracks to make editing efficient.
- **Editing Tools**: Split, duplicate, or delete a clip. You can also expand the audio tracks to make fine tuning with audio easier.
- **Project Panel**: View all of the videos, photos, audio clips, graphics, and sequences within your project.
- **Add media**: Insert a title, more media, or a voiceover to your project. For more information on media, see [Import photos, video, and audio](#).
The Rush Preview monitor

- **Timecode**: The timecode displays the exact time of the playhead position. It also displays the duration of the complete sequence.
- **Player Controls**: Play/pause the video, step forward/backward by one frame, or skip to the next/previous edit point.
- **View/Exit Full Screen**: Watch your video in full screen mode for a bigger preview.
- **Loop Playback**: Play the video on loop, to preview what it will look like on social media channels that auto-loop videos, such as Instagram.

You can change the orientation of your video and adjust your monitor display settings, using the following controls:

- **Orientation**: Choose Landscape, Portrait, or Square for your video.
- **Monitor Quality**: Choose between High, Medium, and Low settings when previewing your video in the monitor.
Introduction to Premiere Rush

Changing the orientation and Monitor Quality

The Rush timeline
The Rush timeline consists of the playhead to view/scrub your timeline and multiple tracks where your media is arranged.

Tracks
Tracks allow you to arrange your clips (videos, photos, graphics, and audio) with flexibility.

While editing a video, you can use multiple tracks primarily for situations like when you want to add music alongside your video or add a title that plays on top of your video.
The Rush timeline consists of one main V1 track. When you import video footage or still images, they are all by default arranged on this V1 track. If you import audio files, or add titles, they are placed in separate audio tracks on the timeline.

In Rush, you can have a maximum of seven tracks on the timeline: four video tracks and three audio-only tracks. Video tracks support video (with or without audio), images, and graphics. Audio-only tracks support audio only clips like music and voiceover recordings.

Each track has controls on the left (when the Control tracks icon is clicked) that allow you to lock a track (to prevent inadvertent edits to it), mute the audio of a track, and show or hide a track.

**Playhead**
The playhead is the blue vertical line that shows you where you are in your timeline when you are previewing your video. The playhead is an essential element to make sure that you are editing and viewing the correct part of your video.

When you click a clip in the timeline, the playhead jumps to that location so that you can preview that selected clip in the monitor as you make edits or watch your video.

**The Rush Share workspace overview**
The Rush Share workspace allows you to save your Rush project on your device or publish it on various social media channels such as YouTube, Facebook, Instagram, and Behance.

Rush Share workspace

If you want, you can adjust the preset, resolution, frame rate, audio channels, and the video quality of your final video, but Rush will automatically choose the highest quality settings based on the media within your project. Lastly, you can preview your video before you export it. For more information, see [Share or export your video](#).
# Keyboard shortcuts

Adobe Premiere Rush CC provides shortcuts to help you quickly work on documents. Many keyboard shortcuts appear next to the command names in menus.

## Keys for File menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard shortcut on macOS</th>
<th>Keyboard shortcut on Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>New &gt; Project</td>
<td>? + ? + N</td>
<td>Ctrl + Alt + N</td>
</tr>
<tr>
<td>New &gt; Sequence</td>
<td>? + N</td>
<td>Ctrl + N</td>
</tr>
<tr>
<td>Close Project</td>
<td>? + ? + W</td>
<td>Ctrl + Shift + W</td>
</tr>
<tr>
<td>Exit</td>
<td>? + Q</td>
<td>Ctrl + Q</td>
</tr>
</tbody>
</table>

## Keys for Edit menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard shortcut on macOS</th>
<th>Keyboard shortcut on Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>? + Z</td>
<td>Ctrl + Z</td>
</tr>
<tr>
<td>Redo</td>
<td>? + ? + Z</td>
<td>Ctrl + Shift + Z</td>
</tr>
<tr>
<td>Cut</td>
<td>? + X</td>
<td>Ctrl + X</td>
</tr>
<tr>
<td>Copy</td>
<td>? + C</td>
<td>Ctrl + C</td>
</tr>
<tr>
<td>Paste</td>
<td>? + V</td>
<td>Ctrl + V</td>
</tr>
<tr>
<td>Select All</td>
<td>? + A</td>
<td>Ctrl + A</td>
</tr>
<tr>
<td>Deselect All</td>
<td>? + ? + A</td>
<td>Ctrl + Shift + A</td>
</tr>
</tbody>
</table>

## Keys for Clip menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard shortcut on macOS</th>
<th>Keyboard shortcut on Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split</td>
<td>? + K</td>
<td>Ctrl + K</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete</td>
<td>Delete, Backspace</td>
</tr>
<tr>
<td>Select Next Clip</td>
<td>? + down arrow</td>
<td>Ctrl + Down</td>
</tr>
<tr>
<td>Select Previous Clip</td>
<td>? + up arrow</td>
<td>Ctrl + Up</td>
</tr>
</tbody>
</table>

## Keys for Sequence menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard shortcut on macOS</th>
<th>Keyboard shortcut on Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom In</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom Out</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
Introduction to Premiere Rush

<table>
<thead>
<tr>
<th>Keys for Timeline</th>
<th>Keyboard shortcut on macOS</th>
<th>Keyboard shortcut on Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom to fit</td>
<td>\</td>
<td>\</td>
</tr>
<tr>
<td>Snap</td>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>Play Audio while Scrubbing</td>
<td>? + S</td>
<td>Shift + S</td>
</tr>
</tbody>
</table>

**Keys for Timeline**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard shortcut on macOS</th>
<th>Keyboard shortcut on Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Next Edit Point</td>
<td>Down</td>
<td>Down</td>
</tr>
<tr>
<td>Go to Previous Edit Point</td>
<td>Up</td>
<td>Up</td>
</tr>
<tr>
<td>Go to Sequence-Clip End</td>
<td>End</td>
<td>End</td>
</tr>
<tr>
<td>Go to Sequence-Clip Start</td>
<td>Home</td>
<td>Home</td>
</tr>
<tr>
<td>Play/Pause</td>
<td>Space</td>
<td>Space</td>
</tr>
<tr>
<td>Select Next Clip</td>
<td>? + Down</td>
<td>Ctrl + Down</td>
</tr>
<tr>
<td>Select Previous Clip</td>
<td>? + Up</td>
<td>Ctrl + Up</td>
</tr>
<tr>
<td>Shuttle Left</td>
<td>J</td>
<td>J</td>
</tr>
<tr>
<td>Shuttle Right</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>Shuttle Stop</td>
<td>K</td>
<td>K</td>
</tr>
<tr>
<td>Step Forward 1 Frame</td>
<td>Right</td>
<td>Right</td>
</tr>
<tr>
<td>Full Screen</td>
<td>`</td>
<td>`</td>
</tr>
<tr>
<td>Fit Sequence</td>
<td>\</td>
<td>\</td>
</tr>
<tr>
<td>Split</td>
<td>? + K</td>
<td>Ctrl + K</td>
</tr>
<tr>
<td>Add Video Transition</td>
<td>? + D</td>
<td>Ctrl + D</td>
</tr>
<tr>
<td>Add Audio Transition</td>
<td>? + ? + D</td>
<td>Ctrl + Shift + D</td>
</tr>
<tr>
<td>Snap</td>
<td>S</td>
<td>S</td>
</tr>
</tbody>
</table>

**Keys for Large Preview**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Keyboard shortcut on macOS</th>
<th>Keyboard shortcut on Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark In</td>
<td>I</td>
<td>I</td>
</tr>
<tr>
<td>Mark Out</td>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>

**Capture and edit videos on the go using the Rush iOS app**

Adobe Premiere Rush CC for mobile provides you a powerful, yet simple solution for capturing, editing, and sharing your videos.
The Rush product functionality is similar across your computer and iOS devices with some minor differences. When you use the Rush app on iOS, you have an extra option to capture videos using the Rush app.

**Install and sign-in to the Rush iOS app**

You can install the Rush app from iTunes.

To install Rush, the minimum hardware and software are required.

- Requires iOS 11 or later
- Compatible with iPhone 7 and newer (devices with A9 ARM chip or higher)
- Compatible with iPad (devices with A9 ARM chip or higher)

Get started creating videos with Rush using the following instructions.

1. On your iPad or iPhone, tap the Rush app icon.
2. Sign in with your Adobe ID.
   
   **Note:**
   
   *Is Facebook or Google supported for sign-in? I don’t see these options in the Rush app that I got from the hockey app.*
3. Get started creating videos using the following instructions.

**Create a new project**

Open Premiere Rush on your mobile device and sign in with your Adobe ID. To create a new project, Tap plus (+).

You can then add media saved on your camera roll, Creative Cloud, or Dropbox. Or you can directly shoot photos or videos using the Rush app.

Rush automatically separates the scenes for you into clips.

**Add photos and videos**

To add existing photos or videos to a project, tap Add Media. To select multiple photos and videos, tap individual thumbnails. Once you’ve made your selections, type in a project name, and tap Create to import them into your project.

Enable Sync with CC if you want to save your video projects on the cloud.
Add existing photos or videos to your project

Capture photos and videos

Use the Rush camera to take photos and videos instead of using the device's native camera app.

You can use its AUTO functions to simply set your focus point and shoot. You can also use a range of manual features such as ISO, shutter speed, white balance, and manual focus. These features give you more creative control when taking photos and videos.

To snap a picture/record video with your device and add it to the project tap plus (+), then tap Capture. The Rush camera defaults to AUTO. You can use the default AUTO setting, or select PRO for more settings, such as shutter speed, white balance, and ISO. Use extra settings to lock/unlock auto exposure or set the resolution or frame rate, and then tap the shutter button to capture the photo. Once done, tap the tick icon to add your photo or video to your project.

Capture options
AUTO settings

A: Grid: A grid dividing the screen into thirds is overlaid on the screen to be used as a guide while you shoot.

B: Flash: There are two Flash options:
- Flash Off: Flash never fires when you take a picture.
- Flash Automatic: Flash only fires when in low light situations.

C: Torch: The light for the flash stays on, whether you are shooting or not.

PRO settings
You can manually control the following settings in PRO mode:

Exposure options
**PRO exposure options in Rush**

A: **ISO:** ISO controls the sensitivity of your device's camera to light.

B: **Shutter:** Shutter speed controls the duration for which your camera is exposed to light. You can adjust this duration to achieve the desired creative effect in your photos and videos.

C: **Exposure Meter:** Automatically calculates the level of exposure based on your ISO and shutter settings.

D: **Auto Exposure:** If you don't want to manually control the PRO exposure options, slide **Auto Exposure** to the right.

**Exposure Bias:** Use the **Exposure Bias** adjustment to either underexpose or overexpose what the camera believes are the correct settings.

**White Balance options**
PRO white balance options in Rush

A: Temp: Temperature refers to the warmth or coolness of a hue.

B: Tint: Tint applies a green to violet type correction to an image.

C: Auto White Balance: If you don’t want to manually control the PRO white balance options, slide Auto White Balance to the right.

Focus and zoom options

PRO focus options in Rush

A: The focus is the distance between the lens and the image sensor when the subject is in focus.

B: If you don’t want to manually control the PRO focus option, slide Auto Focus to the right.
Introduction to Premiere Rush

Zoom option in Rush

Swipe the slider to the right to zoom in on what you are filming.

Resolution and frame rate

A: Resolution: You can shoot 480p, 580p, 720p, 1080p, or 4-K high-definition videos using the Rush camera. Default value is 1080p.

B: Frame Rate: Frame rate is the number of individual frames that include each second of video you record. The most common frame rates while shooting video are 24, 25 and 30 frames per second. Default value is 30 frames per second.

If you are not sure which option to select, stick to the default values.
Trim, split, duplicate, or delete clips

Trim a clip

You can fine-tune the duration of a clip in your timeline by moving the clip's start point or end point. This feature is called trimming.

To select a clip on the timeline, tap it. Orange handles appear around the clip when it is selected. To trim away a portion of the beginning of the clip, go to the beginning or the end of the clip, tap, and hold the thick orange handle and drag it to the right.

You are not trimming the original video. You can drag the thick yellow line to the right to extend the trimmed clip.
Split a clip

Splitting clips

Splitting is useful if you’ve added a clip to a project, but don’t want to use the entire clip all at once.

To split a clip in two, drag the playhead to the place you want the split to occur. Swipe-right on the bottom toolbar and tap the Scissors icon.

After you split a clip, you can rearrange the pieces and move them around separately within your project.
Duplicate or delete a clip

Duplicating a clip before editing is a great idea as you can retain the original clip and do before and after comparisons while editing.

Long-press a clip on the timeline. In the pop-up menu that appears, tap **Delete** to delete the selected clip. Tap **Duplicate** to create a copy of the clip. The duplicated clip appears on the timeline before the selected clip.
Add titles

Move the playhead in your project to the point where you want to add the title.

To add a title, tap the blue (+) button, and then do one of the following actions.

- Tap a preferred style from the choices that appear on the screen.
- Or, drag a preferred style from the choices and drop it on the title in the timeline.

Depending on the title style you pick, there are more options to edit text properties.

Double tap the placeholder text in your monitor, and type in whatever title you like.

To edit text properties such as font, color, and size, tap the EDIT button.

**TIP:** If you are not satisfied with the in-built fonts in Rush, you can use fonts from Adobe Fonts. To view more fonts, tap Adobe Fonts. Then tap the Cloud icon once you choose a font. The font is then available in the Font drop-down list in Rush.
Add audio

Set the mood for your videos with some music. You can add music saved on your phone, or you can add the soundtracks that come with Rush.

Tap the plus (+) icon. Then tap Media > Audio > Add. The audio is added to the audio track.

You can edit your audio just as you can your video clips.

To select the green music track, double-tap it and open the editing options. You can now access all the audio editing options that are available on the desktop Rush app.

To learn what you can do with these audio options, see Adjust your audio clips.
Export video

Click the Export icon at the top of the app and then select one of the following quality settings.

- 1080-30-L
- 720-30-L
- Facebook default
- Youtube default

Tap Render and Rush starts to encode the sequence. Wait for a few moments while Rush renders your video. Do not close the app or lock your phone while rendering is going on.

Once rendering is complete, you are ready to share your video on YouTube, Facebook, Instagram, or Behance.

For more information on export options while exporting to these social media channels, see Share or export your video.
Access synced videos across desktop and mobile

Syncing videos from Rush on your computer to Rush for mobile lets you edit, organize, and share your videos anywhere you take your mobile device. It's a great way to:

• Capture footage and edit videos while on the go.
• Edit the videos further later on desktop when you have the time.
• Share photos from your mobile device to Facebook, Instagram, and other social media.

All changes you make in Rush on your iOS device are reflected in Rush on the desktop. Any changes made in the desktop are synced to mobile as well.

How syncing works

Note:

You need a Creative Cloud membership or trial to sync videos across all your devices.

Project syncing in Rush is managed based on Adobe IDs.

On a given device, you see only the projects for the account that Rush is logged into. If you use multiple Adobe IDs and want to sync projects across multiple devices, make sure that all Rush instances are logged into the same Adobe ID account.

Rush's sync feature manages both the project and its media. Project files are synced to Creative Cloud Files/AdobeRush/Projects/<projectGUID>. Media files are saved to either Creative Cloud or Dropbox. In both cases, the path is ./AdobeRush/Assets/<projectGUID>.

Note:

Rush does not copy media imported from Creative Cloud or Dropbox to managed storage. It is because your media are already in a stored cloud service and your systems can directly access it from the cloud service.

How do I know if my projects are synced?

A synced project is saved on the cloud, making it available for you to edit on all your systems. A project that is not synced exists only on a particular machine.

Icons on the Project browser indicate the sync status of the project.
To understand if your project is synced or not, use the sync indicators in this table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Project exists on device or cloud?</th>
<th>What happens when you tap or click it?</th>
</tr>
</thead>
<tbody>
<tr>
<td>📱</td>
<td>Device only</td>
<td>Project gets uploaded to the server</td>
</tr>
<tr>
<td>📱☁️</td>
<td>Device and cloud</td>
<td>The Rush app checks if there is a newer version on the server. If there is one, it checks whether you want to overwrite your device version. For more information, see <em>How do I resolve sync errors?</em></td>
</tr>
<tr>
<td>☁️</td>
<td>Cloud only</td>
<td>Project gets downloaded to device.</td>
</tr>
<tr>
<td>☁️⌚️</td>
<td>Syncing between cloud and device</td>
<td>Nothing happens, the syncing action is already in progress.</td>
</tr>
</tbody>
</table>

**How do I resolve sync errors?**

If the project version on your device is different from the project available on the server, Rush indicates it with a message when you open your project. You then have to choose whether you want to save a copy of your system project file, or overwrite it with the version that is saved on the cloud.
Resolving sync errors

- Click **Save copy**: To create a copy of your project in the current state. Rush creates a copy of the current project, and the current project is overwritten with the project copy present on the cloud.
- Click **Overwrite**: To overwrite the system copy with the project fetched from the project.

**Common questions**

- **What is Premiere Rush CC?**
  Premiere Rush CC is the first all-in-one, cross-device app for creating and sharing online videos – fast. Edit, fix color, adjust audio, add titles, and more with easy-to-use tools, customizable Motion Graphics templates, and integration with Adobe Stock. And share your videos to your favorite social channels right from the app.
  - **Easy editing**: With an intuitive interface and creative flexibility as you progress, Rush makes editing easy.
  - **Simple timeline**: Arrange scenes with click drag-and-drop ease, access four video tracks, and three audio tracks without gaps in the timeline.
  - **Customizable titles**: Easily add and customize built-in, professionally designed Motion Graphics templates. Hundreds more available on Adobe Stock.
  - **Add audio**: Record voiceovers and use other simple tools like sound balancing, noise reduction, and auto-ducking to make your videos sound great.
  - **One-click share to social**: Add a thumbnail, schedule your post, and publish to multiple social platforms in one click, without leaving Rush.
  - **Available cross device**: Edit on your phone, tablet, or desktop. Your edits are automatically synced to the cloud, so you always have access to your latest versions.
  - **Where can I find more information about Premiere Rush?**
You can learn more about Premiere Rush on these web pages:

- Visit the Premiere Rush product page.
- Follow Premiere Rush on Facebook, Twitter, and Instagram, and YouTube.
- Subscribe to our YouTube PlayList for tutorials and inspiration from the community.

**How do I download Premiere Rush?**

Premiere Rush is available on Mac OS, Windows, and iOS.

1. Mac OS or Windows

   The easiest way to install Premiere Rush is through the Creative Cloud desktop app – simply choose **Install** from the Apps tab. You can also download Rush from the product page.

   If you are a Creative Cloud for teams or Creative Cloud for enterprise member and you don’t have access to the Creative Cloud desktop app, contact your IT Administrator to obtain access to Rush through the Creative Cloud Packager.

2. iOS

   Visit the Premiere Rush page on the iTunes App Store to download the Starter plan for free.

**How do I get started using Premiere Rush?**

Creating videos in Rush is quick and easy.

Available right from the Welcome Screen, Premiere Rush comes with a guided interactive tutorial that walks you through the basics of creating your first video. Learn how to add clips, apply color filters, transitions, and more. To access the tutorial at any time:

- iOS: From the projects screen, open settings (the gear icon). Then tap **Preferences** and select **Start tour again**.
- Desktop: Click **Help > Start Tour Again**.

You can also check out a series of step-by-step Get Started tutorials here.

**Where do I go to suggest features or report an issue with Rush?**

Our team is actively listening to and responding to your feedback - you can look at existing feature requests and issues, vote on them, or add your own on our UserVoice site.

**Where do I get help and support for Rush?**

Visit our Learn & Support page for help and tutorials.

You can also connect with other creators using Premiere Rush on our support forums to share your experiences and get answers to questions.

**In which languages is Rush available?**

Premiere Rush is available in English, French, German, and Japanese. More languages coming soon.

**How does Premiere Rush work with Premiere Pro?**

Premiere Rush projects can be opened natively in Premiere Pro for continued editing. To open a Rush project in Premiere Pro, select **Open Rush Project** from the Start screen in Premiere Pro.

Premiere Pro projects cannot be opened in Premiere Rush.
For more information, see Open Premiere Rush projects in Premiere Pro.

• What are the minimum system requirements for Premiere Rush CC?
  See the Adobe Premiere Rush CC system requirements for more information.

• How does Premiere Rush make it possible to work across mobile and desktop devices?
  When you create a synced project in Premiere Rush, a copy or proxy of the media is uploaded to Creative Cloud automatically. Your other devices can then access that media in Creative Cloud, which seamlessly allows you to continue editing the project.

![Creating a synced project in Premiere Rush](image)

• How much cloud storage does Premiere Rush provide? Can I upgrade my storage?
  The amount of cloud storage depends on your Creative Cloud membership. You can check on your available storage space on both iOS and desktop:
  • iOS: From the projects screen, open settings (the gear icon). Then tap on your name.
  • Desktop: Open the Creative Cloud desktop app and click the three dots next to your avatar in the upper right corner.
  For more information about upgrading your storage, see Adobe Premiere Rush file storage requirements and upgrades.

• How can I optimize my storage space?
  You can optimize storage space by changing the sync settings of any projects you no longer want to edit across devices or by deleting them. In Your Projects (home button), select the three dots underneath a project's thumbnail to either turn off sync or delete it. Either of these options remove any media associated with that project from Creative Cloud and reduce the amount of storage you are using.
  
  **Note:**
  
  *Turning off sync prevents you from working across devices, and deleting a project is permanent, irreversible, and prevents you from accessing it again.*

• How do I turn off cloud sync?
  To turn off cloud sync when you are first creating a project, deselect **Sync with Creative Cloud** on the Project Creation screen.
Creating a synced project

To turn off sync for an already created project, you can do so from the three dots underneath the project thumbnail in Your Projects (home button).

Project Options

- **What happens to my videos and assets if I close or delete my Adobe account?**
  Account deletion is permanent and irreversible. Before you close your account, make sure that you have downloaded all your synced videos and assets stored in the cloud and exported and saved any completed videos from Rush.

- **What happens to my videos if I exceed my allotment of cloud storage?**
  If your storage space is exceeded, you can still use Rush and create projects. However, new projects and any media you add to new or existing projects do not sync to Creative Cloud. So, any devices other than the one where the clips are created/located cannot be used. Any media that you add before running out of storage space is available for you across devices (unless the project was deleted or project syncing was turned off).

- **What is the legal status of the soundtracks included with the app?**
The soundtracks provided in Premiere Rush can be used freely for personal or commercial use. See the Adobe Terms below.

Your use of the soundtracks is covered in section 2.5 of the Adobe Terms of Use (http://www.adobe.com/legal/terms.html). You can include the soundtracks as part of a Premiere Rush project for your clients, but you cannot distribute (or make them available) on a stand-alone basis.

To use a soundtrack from Rush, select Rush Soundtracks from the Favorites section of the Media Browser.

Rush soundtracks accessible from the Media Browser

- **How much does Premiere Rush cost?**
  Premiere Rush is available for free as part of a Starter plan and there are also paid plans available. Visit the compare plans page to see the different paid plan options.

- **What is the free Starter plan?**
  This free plan is available to anyone with a free Creative Cloud membership and includes Premiere Rush, 2 GB of Cloud Storage, and up to three exported projects. Start Premiere Rush for free here.

- **What is an export? How many do I get for free?**
  An export is the way that a Rush project becomes a video that can be saved or shared. Any time that you want to save a video you’ve created in Rush on your computer or mobile device, or share it to social media, you must export it first. If you are on the Starter plan, you can only export up to three projects. To export more than three projects, upgrade to a paid plan.

- **How do I upgrade from the Starter version to the paid plan?**
  For more information on upgrading Rush, see Upgrade from the Starter plan to the paid plan.

- **Which paid plans include Premiere Rush?**
Premiere Rush is included in the following plans:

- **The Premiere Rush Single App plan** includes Rush with unlimited exports, 100 GB of cloud storage, Adobe Fonts, Adobe Portfolio, and Adobe Spark with premium features.

- **The Premiere Pro CC plan** includes Premiere Pro and Premiere Rush - with unlimited exports, 100 GB of cloud storage, Adobe Fonts, Adobe Portfolio, and Adobe Spark with premium features.

- **The Creative Cloud All Apps plan** includes all of the creative applications (Premiere Rush, Premiere Pro, After Effects, Photoshop, Illustrator, and more) required to create professional videos and images, plus 100 GB of cloud storage, Adobe Fonts, Adobe Portfolio, and Adobe Spark with premium features.

- **Does Premiere Rush come with the Premiere Pro Single App plan?**
  Yes, Premiere Rush is included in the Premiere Pro Single App plan.

- **Is Premiere Rush available in the Student, Creative Cloud Team, and Enterprise plans?**
  Yes, Premiere Rush is available in the Student, Creative Cloud Team, and Enterprise plans.

## Adobe Premiere Rush CC system requirements

**Applicable for:** October 2018 release (version 1.0)

**Note:**

To install and use Adobe Premiere Rush, you need Windows 10 (v1709 or later), or macOS 10.13 or later.

Adobe Premiere Rush is not supported on Windows 7, Windows 8.x, Windows 10 (v1511 and v1607), or macOS 10.11 (El Capitan) and 10.12 (Sierra).

### Upgrade your operating system

If you cannot upgrade your desktop operating system for any reason, you can use the Rush mobile app on your iOS device. See iOS system requirements for the list of supported mobile devices. For additional questions, see Frequently asked questions.

## Minimum system requirements for Premiere Rush CC
Windows

<table>
<thead>
<tr>
<th></th>
<th>Minimum requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Multicore processor with 64-bit support (Recommended: Intel Core i5 or i7, or equivalent)</td>
</tr>
</tbody>
</table>
| Operating system    | Microsoft Windows 10 with 64-bit support (Version 1709 or later)  
For information on upgrading your Windows OS version, see [Get Windows 10].  
**Note:** If you are unable to upgrade your operating system because of hardware limitations, you can still use Rush on iOS. For more information, see the [iOS system requirements]. |
| RAM                 | 8 GB of RAM                                             |
| Hard disk space     | 8 GB of available hard-disk space for installation; extra free space required during installation (cannot install on removable flash storage devices) |
| Monitor resolution  | 1280x800 display (1920x1080 or larger recommended)      |
| Sound card          | Sound card compatible with ASIO protocol or Microsoft Windows Driver Model |
| Internet            | Internet connection and registration are necessary for required software activation, validation of subscriptions, and access to online services.* |
| Optional            | Adobe-recommended GPU card for GPU-accelerated performance |

- Multicore processor with 64-bit support (Recommended: Intel Core i5 or i7, or equivalent)
- Microsoft Windows 10 with 64-bit support (Version 1709 or later)
- 8 GB of RAM
- 8 GB of available hard-disk space for installation; extra free space required during installation (cannot install on removable flash storage devices)
- 1280x800 display (1920x1080 or larger recommended)
- Sound card compatible with ASIO protocol or Microsoft Windows Driver Model
- Optional: Adobe-recommended GPU card for GPU-accelerated performance
- Internet connection and registration are necessary for required software activation, validation of subscriptions, and access to online services.
macOS

<table>
<thead>
<tr>
<th>Minimum requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
</tr>
</tbody>
</table>
| Operating system    | macOS X v10.13 or later  
For information on upgrading your macOS version, see Upgrade to macOS High Sierra.  
**Note:** If you are unable to upgrade your operating system because of hardware limitations, you can still use Rush on iOS. For more information, see the iOS system requirements. |
| RAM                 | 8 GB of RAM |
| Hard disk space     | 8 GB of available hard disk space for installation; extra free space required during installation (cannot install on a volume that uses a case sensitive file system or on removable flash storage devices) |
| Monitor resolution  | 1280 x 800 display (1920 x 1080 or larger recommended) |
| Sound card          | Sound card compatible with Apple Core Audio |
| Internet            | Internet connection and registration are necessary for required software activation, validation of subscriptions, and access to online services.* |
| Optional            | Adobe-recommended GPU card for GPU-accelerated performance |

- Multicore Intel processor with 64-bit support (Recommended: Intel Core i5 or i7, or equivalent)
- macOS X v10.13 or later
- 8 GB of RAM
- 8 GB of available hard disk space for installation; extra free space required during installation (cannot install on a volume that uses a case sensitive file system or on removable flash storage devices)
- 1280x800 display (1920x1080 or larger recommended)
- Sound card compatible with Apple Core Audio
- Optional: Adobe-recommended GPU card for GPU-accelerated performance
- Internet connection and registration are necessary for required software activation, validation of subscriptions, and access to online services.

iOS

- Requires iOS 11 or later
-Compatible with iPhone 7 and newer (devices with A9 ARM chip or higher)
- Compatible with iPad (devices with A9 ARM chip or higher)
Language versions available for Premiere Rush CC
Adobe Premiere Rush is available in the following languages:

- English
- French
- German
- Japanese
Chapter 2: Import footage

Import photos, video, and audio

You can bring in your video clips, photos, graphics, and audio files that you have stored on your computer or your external drive. You can also bring in media from your Creative Cloud, Dropbox, iCloud Drive, and Google Drive using the Media Browser in Rush.

Note:
If you are trying out Premiere Rush for the first time, you can bring in the sample media packaged with Rush to create your first video.

About the Media Browser
The left side panel includes the following main sections:

- **Local**: Media is saved on your local computer.
- **Cloud**: Media stored in the cloud such as in Creative Cloud, or iCloud.
- **Network (only shown if additional drives are mounted to the device)**: Media stored in network-mounted drives.

The right side displays your content.

You can use the filters on the lower left to filter and sort your media:

- **Sort**: You can sort media by name or date created.
- **Filter**: You can filter media by all media, videos only, audio only, or images only.

The Media Browser allows you to quickly and easily find the media you want to use in your Rush projects. You can preview the media in the media browser before bringing it into a project by clicking on the expand preview button under each clip (on desktop) or long/force pressing on a clip (on mobile). From there, you can also select a certain portion of that clip if you only need a short snippet of a longer video clip.

**Create a project and add media files**

When you launch Rush and start a new project, you first need to select and import your media. You can import media on your computer or in the cloud (such as Creative Cloud or iCloud). If you are connected to an office network, you can also import media from a network location.

1. On the home screen, select **Create a New Project**.

   You can now add photos, videos, and audio clips saved on your computer, in the cloud, or in a shared network location.
2 Click media to select it. Select your media in the order you want it to appear on the timeline.

Rush marks all the clips in the order you select them and arranges them at the bottom of the screen in a storyboard, allowing you to preview how the media is going to be assembled in the timeline.

If you are not satisfied with the order of the assets, you can deselect them by clicking them. You can then select your assets again in the order in which you want them to appear.

Click Create.

After you click Create Rush automatically adds all of your selected media to a sequence (by default, named Sequence 01), and the project is available for you to start editing in the Edit workspace.

3 Select Sync with Creative Cloud if you want your video project to be saved to the cloud so that you can access it across your mobile devices and desktop. All of your edits are synced to the cloud, so you always have the latest version of your project across your devices. Select Copy Media if you want to save a copy of the selected media on your device; this is useful if you are importing media from a detachable device.

Rush saves the media in the folder that you specify in the Preferences dialog. By default, the media is stored in Premiere Rush/Imported Media folder.
**Add media files to existing projects**

To add media to your project while editing, click the + icon in the left toolbar, and then select Media. The Media Browser opens on the left of the application. Use the navigation buttons at the top to view folders and select your media. After you have selected all of your media, click Add.

Rush adds the media that you have selected into the sequence. They appear in the timeline where the playhead is positioned.

**Set audio, input/output and rendering preferences**

1. To open the Preferences dialog select **Edit > Preferences** (Windows) or select **Premiere Rush > Preferences** (Mac).
To set Media Import preferences, click Choose to change the default location for where your copied media is stored. Navigate to the folder where you want to save your media, and click Choose again.

If you have multiple audio input and output options for your computer, you can set your input and output audio preferences.

By default, Rush uses the built-in output and the built-in microphone for your system.

Select Pre-render sequences for playback if you are having playback or performance issues.

When this option is selected, Rush pre-renders parts of your sequence in the background to optimize playback.

To remove all cache files and free up disk space, click Clear Cache option.

Click OK.

**Supported video and audio formats for import**

Rush supports several audio and video formats, making your editing workflows compatible with the latest file formats.
## Video formats

<table>
<thead>
<tr>
<th>File format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple ProRes</td>
<td>Apple video compression format</td>
</tr>
<tr>
<td>DNxHD</td>
<td>Supported in native MXF and QuickTime wrappers</td>
</tr>
<tr>
<td>DNxHR</td>
<td>DNxHR LB, DNxHR SQ, DNxHR TR, DNxHR HQ, and DNxHR HQX</td>
</tr>
<tr>
<td>GIF</td>
<td>Animated GIF</td>
</tr>
<tr>
<td>H.264 AVC</td>
<td>Any media that uses H.264 encoding</td>
</tr>
<tr>
<td>HEVC (H.265)</td>
<td>H.265 media with resolutions up to 8192x4320</td>
</tr>
<tr>
<td>M2T</td>
<td>Sony HDV from Sony Handycams</td>
</tr>
<tr>
<td>M2TS</td>
<td>Blu-ray BDAV MPEG-2 Transport Stream, AVCHD (from Sony Handycams)</td>
</tr>
<tr>
<td>MOV</td>
<td>MPEG-4 video file</td>
</tr>
<tr>
<td>MP4</td>
<td>QuickTime Movie, XDCAM EX</td>
</tr>
<tr>
<td>MTS</td>
<td>AVCHD (broadcast format but also used in Canon camcorders)</td>
</tr>
<tr>
<td>MXF</td>
<td>Media eXchange Format. MXF is a container format that supports • P2 Movie: Panasonic OP1b variant of MXF video in AVC-Intra LT and AVC-LongG, Panasonic Op-Atom variant of MXF video in DV, DVCPRO, DVCPRO 50, DVCPRO HD, AVC-Intra • Sony XDCAM HD 18/25/35 (4:2:0) • Sony XDCAM HD 50 (4:2:2) • AVC-LongGOP • XAVC Intra • XAVC LongGOP • IMX 30/40/50 • XDCAM EX</td>
</tr>
</tbody>
</table>

## Audio formats

<table>
<thead>
<tr>
<th>File format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAV</td>
<td>Windows Waveform</td>
</tr>
<tr>
<td>AIFF, AIF</td>
<td>Audio Interchange File Format</td>
</tr>
<tr>
<td>MP3</td>
<td>mp3 audio</td>
</tr>
<tr>
<td>M4A</td>
<td>MPEG-4 audio (iTunes format)</td>
</tr>
<tr>
<td>AAC</td>
<td>Advanced Audio Coding</td>
</tr>
</tbody>
</table>
## Still image formats

<table>
<thead>
<tr>
<th>File format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP, DIB, RLE</td>
<td>Bitmap</td>
</tr>
<tr>
<td>GIF</td>
<td>Graphics Interchange Format</td>
</tr>
<tr>
<td>JPEG</td>
<td>JPE, JPG, JFIF</td>
</tr>
<tr>
<td>PNG</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>PSD</td>
<td>Photoshop, flattened when it comes into Rush</td>
</tr>
<tr>
<td>HEIF</td>
<td>High Efficiency Image File Format</td>
</tr>
</tbody>
</table>

## Native camera formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ARRI AMIRA camera</strong></td>
<td>Rush provides built-in support for the ARRI AMIRA camera, with appropriate color LUTs applied as master clips on import.</td>
</tr>
<tr>
<td><strong>Canon XF</strong></td>
<td>You can work natively with Canon XF and Canon RAW footage, including footage from Canon Cinema EOS C300 and C500 cameras. Rush lets you import and edit QuickTime formats natively including Apple ProRes and MOV files that Canon 5D and 7D cameras capture.</td>
</tr>
</tbody>
</table>
| **Panasonic AVC, P2 cameras** | You can import and edit media from the following cameras/camera codec formats:  
  * Panasonic AVC Ultra  
  * Panasonic AVCi 200  
  * Panasonic AVC Ultra Long GOP (Group of Pictures)  
  * Panasonic P2 cameras and across multiple P2 cards |
| **Sony cameras** | You can import and edit media from the following cameras directly, without rewrapping or transcoding:  
  * Sony XDCAM  
  * Sony XDCAM 50  
  * Sony XAVC  
  * Sony XAVC LongGOP (Group of Pictures)  
  * Sony XAVC-S  
  * Sony SSTP |
Chapter 3: Edit video

Edit your video in the timeline

After you create a project in Rush, you can start editing your project in the timeline. Generally at this stage of editing, you trim clips, move them around, add more video clips, delete clips - basically narrowing down the footage to the key areas that you want your video to cover. For example, if you are editing a travel video, you can remove boring footage showing repetitive videos of the same area.

At this point in your editing workflow, the focus is not as much on enhancing your video (using techniques such as adding transitions, text, or color correction). The aim here is to make sure your video follows a particular narrative in the order you want and that all extra footage is removed.

Here are some common tasks that you will perform while editing your video in the timeline:

- Move or rearrange clips
- Trim clips
- Split clips
- Duplicate clips
- Manage tracks

Before you start editing, take a minute to understand a bit about the Rush timeline and its capabilities.

Understanding the Rush timeline

The Rush timeline is a Non-Linear Editor (NLE). The timeline allows you to add, trim, or split, arrange, and duplicate clips – basically manipulate the video, so it looks, sounds, and feels the way you want it. The nonlinear part means that you don't have to put the media onto the timeline in linear or sequential order. You can arrange the media in any order and use additional tracks to stack or layer clips.

Working with the Rush tracks in the timeline

The Rush timeline consists of one main video (V1) track. When you import video footage, still images, or graphics they are all by default arranged on this V1 track.

If you import audio files or add titles, those clips are placed in separate tracks on the timeline.

In Rush, you can have a maximum of seven tracks on the timeline: four video tracks and three audio-only tracks. Video tracks support video (with or without audio), images, and graphics. Audio-only tracks support audio only clips such as music and voiceover recordings.

The main V1 track is gapless - When you import footage, Rush automatically assembles all clips in this track next to each other with no gaps in between clips. It is lighter in color than the other tracks, as a visual indicator to you that this track is your main video track and has special gapless properties.

Clips placed on tracks V2-V4 and A1-A3 are associated with clips in the main V1 track, keeping your clips in sync.
**How Rush associates clips in the timeline**
When you select a clip on the V1 track, clips that are associated with it on tracks V2-V4 and A1-A3 display a yellow line along its bottom edge and a vertical yellow line showing the connection point to the clip in the V1 track.

Visual indicators showing clips associated with the clip in the main V1 track

**Move or rearrange clips**

Click a clip that you want to move in the timeline; an orange border appears around the clip to indicate that it is selected.

To select multiple clips, place your cursor and hold down to lasso multiple clips. Press the Ctrl or Command key and click individual clips to select multiple non-adjacent clips.

For multiple, adjacent clips that are selected, you can drag the selected clips to a new location in the timeline to rearrange them. You can also move those clips to other tracks.
TIP: You can use this technique to create cutaway shots (for example, where you show two different perspectives of a single event).

Trim clips

You can fine-tune the duration of a clip in your timeline by moving the clip's start point or end point. This is called trimming.

Click on a clip to select it. Orange handles appear around the clip when it is selected. Click-hold and drag Go to the beginning or the end of the clip, hold the thick orange handle and drag it to the right to trim away a portion of the beginning of the clip.

Note:

Trimming clips does not trim the original video. You can drag the thick yellow line to the right to extend the trimmed clip at any time.

Split clips

Splitting is useful if you've added a clip to your timeline, but don't want to use the entire clip all at once.

To split a clip in two, select the clip in the timeline and drag the playhead to the place you want the split to occur (you can also use the < and > keys or zoom into the timeline to get a precise cut) and then click Split (the Scissors icon in the left toolbar).

After you split a clip, you can rearrange the two clips and move them around separately within your timeline.
Duplicate clips

Duplicating a clip before editing is a great idea as you can retain the original clip and do before and after comparisons while editing.

Select a clip on the timeline, and click the Duplicate icon in the left toolbar.

If the selected clip is on the main V1 track, then Rush duplicates the clip and adds the new clip after the original clip on the timeline.

If the selected clip is an audio clip, or a title, then Rush duplicates the clip and add the new clip at the exact spot as the original but in a new track.

Manage tracks

You can hide tracks on the timeline to make editing easier on other tracks. You can also lock tracks to prevent changes.

To show and hide tracks: Click the Eye icon.

To lock and unlock tracks: Click the Lock icon.

To mute and unmute audio: Click the Loudspeaker icon.

Add and refine audio

You can add pre-recorded audio clips to your project, or record voice-overs or other audio directly into your timeline.

Record audio and voiceovers

To start recording a voice-over, click the blue + icon in the left toolbar and select Voiceover. The track controls expand, revealing a red button to start recording your voice-over.

Now, you have options to:

• Start and stop recording
• See audio tracks appear at the bottom of the timeline; you can move audio clips around within these tracks, or choose to record on a different audio track

![The Rush user interface for recording voiceover](image)

A Start or Stop Recording  B Recorded Voiceover

1 Record a voice-over right into the timeline. Click on the microphone icon in the audio track to which you want the voice-over clip recorded. This turns the microphone icon into a red button, which allows you to start and stop the voice-over recording. Position the playhead where you want to begin recording.

![Audio tracks that can be used for recording voiceover](image)
2 To start recording, click the red **Record** button in the audio track to which you want the voice-over clip recorded. Rush moves the playhead back three seconds and displays a 3–2–1 countdown in the Preview monitor, so that you can prepare for your recording. You can also hear the sound cues during the countdown. Audio is not recorded until the countdown is complete. When the countdown finishes, begin your voice-over or other audio input.

![Voiceover countdown](image)

3 To stop the recording, click the same red **Stop** button.

The audio clip appears in the audio track, beginning where the playhead was originally positioned.

This audio clip is just like any other clip in your timeline, so you can trim, split, duplicate, or delete it. You can also add transitions to it, or refine it further in the audio panel.

Recorded audio clips appear as audio items in the Project panel. If you no longer need these voice-over clips in your project, you can delete them from the Project Panel (they need to be removed from the timeline first). Voice-over clips are named **Voiceover** with incrementing numbers.

**Add and edit pre-recorded audio**

You can add audio like music, a pre-recorded voice-over, or sound effects by clicking the blue + button and selecting **Add Media**.

Use the Audio panel in Rush to refine your audio. This panel provides simple controls to repair sound, improve clarity, and add audio enhancements that help your videos sound professionally mixed.

**About the Audio panel**

The Audio panel contains various controls and settings grouped into three sections: Basic, Advanced, and Channels.

- **Basic**: Adjust the volume of the selected clip, or mute it.
• **Advanced**: Refine the clip using contextual controls based on the type of audio (Voice, Music, or Other); you can change the type of audio here as well.

• **Channels**: This section allows you to view and mute individual channels within your audio clip.

---

**Note:**

The *Channels* section is only available on desktop. It is not available on iOS devices.

---

**Adjust your audio clips**

You can do some basic adjustments to your audio clips. Move the Clip Volume slider to increase or decrease the audio volume of a clip. You can also mute an audio clip by selecting **Mute**.

---

**Classify your audio clips**

When you import a clip that has audio - such as an A/V clip or audio only clip, Premiere Rush automatically detects the audio type as either Voice, Music, or Other.

If you want to change the audio type, select the clip in the timeline and choose another audio type in the Advanced section of the Audio panel.
Classify Audio Clips

After a clip is assigned an audio type, for example Voice for a voiceover clip, the Advanced section of the Audio panel presents you with contextual controls for that audio type. This allows you to improve the way your audio clip sounds with easy-to-use options.

Refine Voice clips

If an Audio clip is classified as a Voice clip, you can adjust it using the following options:
Edit Voice Clips

Voice clip editing options

Automatically adjust volume levels

Auto Volume

Select **Auto Volume** to automatically adjust volume levels (either up or down) as needed so that all audio volume in your entire project sounds consistent.

This is turned on by default for all audio clips, so that any audio clips you bring into your project sound great. You can turn this off by selecting the audio clip and unselecting the **Auto Volume** box in the **Advanced** section of the Audio panel.

Balance volume levels in your audio clip
Balance Sound
Select **Balance Sound** if you want to make quiet sounds louder, and loud sounds quieter throughout your clip. This option can be especially useful if you have voices at different volumes within the same clip.

Reduce background noise
Select **Reduce Background Noise** to remove any steady state background noise from your clips. This option is useful to remove air conditioning noise or any type of background hiss that is inadvertently recorded in your audio clips. Use the Intensity slider to control the amount of noise removed.

Reduce echo
Select **Reduce echo** to remove any room reflections, echo, or reverberation from recordings. This option is useful to remove the boxy, echoed sound that is common when recording in smaller or reverberant rooms.

The Intensity slider controls the amount of echo and reverb removed.

Enhance speech
Select **Enhance speech** to apply a preset that improves the sound quality of a male or female voice.

Refine Music clips
If an audio clip is classified as a Music clip, you can adjust it using the following options:
Refine Music Clips

Music clip editing options

Automatically adjust the volume levels

Auto Volume

Select Auto Volume to automatically adjust volume levels (either up or down) as needed so that all audio volume in your entire project sounds consistent.

This is turned on by default for all audio clips, so that any audio clips you bring into your project sound great. You can turn this off by selecting the audio clip and unchecking the Auto Volume box in the Advanced section of the Audio panel.

Automatically turn down background music when voices are present

Auto Duck
Select **Auto Duck** to automatically reduce the volume of music clips when Voice clips - such as a voiceover or an A/V clip with talking - are present in your timeline. This option makes it easier to hear the Voice clips, while music is playing in the background.

Rush automatically tracks any changes to audio clips in the timeline and adjusts the ducked portions of the music clip for you. Control the amount of Auto-Ducking using the **Reduce by** slider.

Moving the slider to the left with a lower value means that the music gets louder and the duck less intense. Moving the slider to the right with a higher value means that the music gets quieter and the duck more intense.

**Order or reorder audio channels**

You can manipulate the audio channels within an audio clip. Twirl open the Channels section of the Audio panel to see the channels within the audio clip, and reorder them by dragging them up or down.

You can also enable or disable audio channels by clicking the channel labels (for example, L or R).

## Adjust transitions, color, and other media properties

### Add and edit transitions

To add a transition to the start and end of the clip, select a clip, and click any transition in the Transitions Inspector. If you want to add and edit the transition at the same time, double-click the transition, and edit its duration.

To delete a transition, select the transition on the timeline, and press delete on the keyboard.

To edit the duration of an existing transition, double-click the transition to edit its duration in the Transition panel. You can also tweak a transition's duration on the timeline.

You can edit the duration of a transition on the timeline or in the Transition panel

### Adjust a clip's color

You can adjust a clip's color by applying a quick automatic color adjustment (a preset), or individually adjusting exposure, contrast, highlights, shadows, temperature, tint, vibrance, saturation, and other color controls. You can also add a preset, and then edit the color further.
Adjust a clip’s color

To add a preset, select a clip in the timeline, click the Color Inspector, and choose a preset. Once you choose a preset, you can simply adjust the intensity of the preset by using the Intensity slider, which is pinned to the bottom of the Presets tab, or you can further edit the color properties. You can also create a customized preset, which can be used in other projects.

To further edit the color properties, double-click the preset, or select the Edit option, next to the Presets option. The Color Settings switch turns on automatically. The color adjustment settings are grouped into Basic and Advanced accordion controls.
Adding a color preset, tweaking its intensity, and editing the color properties

**Basic:**

- Exposure: Adjust the exposure of the clip.
- Contrast: Adjust the contrast of the clip.
- Highlights: Adjust the brightness of the light areas in the clip.
- Shadows: Adjust the darkness of the darker areas in the clip.
- Temperature: Fine-tune the white balance by moving the slider to the left to make the video appear cooler, and to the right for warmer colors.
- Tint: Fine-tune the white balance by moving the slider to the left to add green to the video, and move it to the right to add magenta.
- Vibrance: Adjust the intensity of the more muted colors in the clip with less effect on the higher-saturated colors.
- Saturation: Adjust the saturation of all colors in the clip equally from 0 (monochrome) to 200 (double the saturation).

**Advanced:**

- Faded Film: Apply a faded film effect to the clip.
- Sharpening: Adjust edge definition to create a sharper-looking video.
- Vignette - Amount: Set the amount of lightening or darkening along the edges of an image.
- Vignette - Feather: Define the edge of the vignette. A smaller value creates a harder, sharper edge, whereas, a larger value indicates a softer, thicker edge.
Create Presets
You can create and save your own custom presets for later use, which include the color preset and the settings from the Edit tab. The created presets are saved into the "Your Presets" category in the Presets list.

To create a preset, click the Color Inspector, choose the ••• (more options) button, and select Create Preset option. Once you save the preset, choose the Edit option and adjust the settings.

Crop and Rotate a Clip
You can modify the appearance of your clip using crop, rotate, scale, or a picture-in-picture effect. To use these effects, select the clip on the timeline and choose the Crop and Rotate option. The adjustment settings are grouped into Basic and Advanced accordion controls.

Basic:
The Basic accordion lets you adjust the position and scale of the clip.
**Basic Transform Settings**

- **Horizontal Position:** Adjust the Horizontal position of the clip.
- **Vertical Position:** Adjusts the Vertical position of the clip.
- **Rotation:** Rotates the object +180° when dragging to the right and -180° when dragging to the left.
- **Scale (Maintain Proportions):** This check box, when checked, adjusts the scale width and scale height uniformly on both axes. When the check box is Off, the width and height can be adjusted independently.
- **Scale Width:** Adjust the width of the clip.
- **Scale Height:** Adjust the height of the clip.

Here is an example showing how you can tweak some of these properties in your clip. For example, if you are travel vlogging, you can use these transform properties to remove unwanted elements from your video and change the focal point.
Using transform properties to change the focal point of your video clip

**Advanced:**
The Advanced accordion lets you crop the edges, and modify the appearance of the clips.
Crop:

- **Crop Top**: Crop the top edge of the clip.
- **Crop Bottom**: Crop the bottom edge of the clip.
- **Crop Left**: Crop the left edge of the clip.
- **Crop Right**: Crop the right edge of the clip.

Appearance:

- **Opacity**: Adjusts the opacity of the clip.
- **Edge Feather**: Applies an edge feather to all edges of the object.

*Note:*

The *Edge Feather* effect applies to the original edges of the object. If cropping is applied, edge feathering is not visible.

**Change the Sequence Aspect Ratio**

You can create sequences in Landscape, Portrait, and Square aspect ratios. You can also change the aspect of the sequence at any time during the editing process.

To change the aspect ratio of the sequence, click ••• (More Playback and Sequence Option) at the bottom of the project monitor. Click or hover your mouse over *Orientation* option, and choose between Landscape, Portrait, or Square aspect ratios.

After you change the orientation of the sequence, you can adjust the scale and position of the clip on the project monitor, so that the focus is on the most important part of the clip.
Changing the orientation and focus point of a video clip

To scale a clip, select a clip in the Timeline, click the clip in the preview monitor, and the scale widget appears. Click drag-and-drop the corners of the scale widget.

To reposition the clip, select a clip in the Timeline, click the clip in the preview monitor, and the scale widget appears. Click drag-and-drop the clip on the preview monitor.

Add and edit titles

You can add and edit titles using the Title panel in Premiere Rush.

To add a title, place the playhead where you would like your title to appear. Click the blue + button on the left toolbar, and select Title.

Rush adds a default title clip at the playhead position. In addition, the Title panel opens and provides you with a variety of built-in, customizable templates and many more available on Adobe Stock.
The Title panel allows you to choose from a selection of built-in Motion Graphics templates, import a Motion Graphics template you already have, or access hundreds more from Adobe Stock. After choosing a template, customize the text, font, and color.

The panel contains a Styles and Edit tab, and a secondary My Templates and Adobe Stock tab. The ... button allows you to import or save a custom template.

Add titles to sequence
You can browse and search templates using the **Styles** tab.

- The **My Templates** tab allows you to view, filter, and search Motion Graphic templates that are on your device or in your Creative Cloud Libraries.
- The **Adobe Stock** tab allows you to browse and use templates from Adobe Stock, including titles, intros/outros, lower-thirds, transitions, and graphics.

The **Edit** tab allows you to customize the titles.

For more information, see [Jazz up your titles using professionally designed Motion Graphics templates](#).

**Add titles and graphics**

1. Click the blue + button in the left toolbar, and click **Title**.

Rush adds a default title clip to your timeline, showing you a preview of it in your Preview monitor as well.

The Title panel also appears on the right, allowing you to choose a different style if you like. Click on a different template in the panel to swap out the style; you can choose from templates in **My Templates** or **Adobe Stock**.
2 Double-click the text in the Preview monitor to edit it.

3 With the title clip selected in the timeline, click the Preview monitor to bring up blue handles that allow you to adjust the position and size of the template. You can move it anywhere on the monitor. You can also adjust where the title clip starts and ends by adjusting it in the timeline by using the orange trim handles around the clip or by moving the clip around in the timeline.
Adjust position and size of the template
Adjust the position and duration of the template

4 Customize the appearance of your text and graphics using the **Edit** tab of the Title panel, including font, font size, and other format and appearance controls.

**TIP:** Click or tap the Star icon next to your favorite fonts in the Font drop-down list that you plan to use in the future. This allows you to filter and search only for your favorite fonts. For more information, see [Filter fonts](#).
If you want additional font options, you can add fonts from Adobe Fonts. For more information, see Add fonts from Adobe Fonts.

**Delete title clips**

To delete a title clip, select the clip in the timeline and click the Delete icon on the left toolbar.

**Add fonts from Adobe Fonts**

Adobe Fonts is a subscription service offering access to a vast library of fonts for use. All Creative Cloud users have Adobe Fonts plan included with a Creative Cloud subscription.

Rush is integrated with Adobe Fonts, bringing a world of typographic possibilities to your video projects.

To add and use fonts from Adobe Fonts:

1. In the Font dropdown list of the Title panel, click on the Creative Cloud icon next to Add Adobe Fonts.
Rush takes you to the Adobe Fonts website.

2 Select the desired fonts and then click sync. The Creative Cloud desktop app initiates the process and syncs the fonts to your machine, making them available in Rush.

The fonts that you choose to sync from Adobe Fonts are available in the font menu.

**Filter fonts**

You can use filters so that only fonts from the Adobe Fonts library, or your favorite fonts are displayed.

- To view only the fonts from Adobe Fonts that are synced to your computer, click the Creative Cloud icon.
• To view only the fonts that you have marked as a favorite, click the Star icon.

Filtering to display only fonts from Adobe Fonts

Filtering to display only the fonts that you have marked as a favorite

**Jazz up your titles using professionally designed Motion Graphics templates**

Motion Graphics templates are created by a motion graphics artist in either After Effects or Premiere Pro. You can use these professionally created templates.
Such graphic templates deliver an overall aesthetic with specific components such as titles, lower 3rds, bumpers, and closing credits. You can select an appropriate template from the ones available within the Title Inspector, or browse Stock for hundreds of other template options.

You can then change variables such as text, color, size, layout, or mood of the motion graphic template without changing the overall aesthetic.

Rush ships with sample Motion Graphics templates. You can also bring Motion Graphics templates into Rush from the following locations:

- Local Templates Folder
- Creative Cloud Libraries
- Adobe Stock

**Import Motion Graphics templates stored on your computer**

You can install a Motion Graphics template (*.mogrt) file from your computer into Rush. When you import Motion Graphics templates, you copy it into Rush's Local Templates folder. The template is available to you in the Title Inspector, and you can use it in any Rush project.

1. To import a Motion Graphics template into Rush, click the ... icon.
2. Select **Install Template** (Mac), or **Import Template** (Windows).
3. Navigate to a Motion Graphics template you want to import. The template is copied to Rush's Local Templates folder.

**Note:**

*Any Motion Graphics template that is stored in your Creative Cloud Libraries does not need to be imported, it is automatically available to use in Rush.*
### Browse and manage Motion Graphics templates

In **My Templates** view, you can do the following:

- Enter a keyword in the search bar to quickly find exactly what you are looking for. Use the drop-down list to view templates available locally, or across your Libraries.
- Favorite a Motion Graphics template by clicking its star icon, then use the Favorites filter near the search bar to quickly view all your favorites at once.

### Use Motion Graphics templates from Adobe Stock

Adobe Stock has thousands of professionally designed titles, lower thirds, transitions, and graphics. You can browse Adobe Stock from the Title Inspector to find and customize exactly the graphic you need.

**Note:**

*Need to verify with build.*

1. In the **Title Inspector**, select **Adobe Stock**.

2. Enter your search term and press Enter.

3. License the Motion Graphics template by dragging it to your sequence, or use the License and Download icon.

4. To learn more about a Motion Graphics template or to preview its animation, click the “i” icon beneath its thumbnail.

   You can also license the Motion Graphics template to your Local Templates folder using the License or Download icon from this view.

### Add Motion Graphics templates to a sequence

1. To add a Motion Graphics template to your sequence, open the Title Inspector and click the **Browse** tab.

2. Select the template that you want to use and drag it into a video track in your sequence.
When you add a template to a sequence, Premiere Rush shows the media as offline until the template completes loading. If the template that you added require fonts that have not been installed, you can resolve the fonts that are missing.

After adding a template to your sequence, you can customize it in the Edit tab of the Title Inspector to modify its appearance.

**Customize your Motion Graphics template**

You can customize your Motion Graphic templates as per your preference. To customize a template, place the playhead on the template in your sequence. Click **Titles** and choose the **Edit** option.

The template properties get updated as you change the controls.
Chapter 4: Export video

Share or export your video

After editing your video, you can save it on your computer, or share it on your social media channels such as YouTube, Facebook, Instagram, or Behance.

When you share, you can add metadata, custom thumbnails, schedule videos, and control advanced custom render settings.

Save video to local computer

To save your completed video to your local system:

1. Click the Share button in the toolbar, and then click Local.
2. In the dialog box that appears, set the following options:
   - **File Name**: Edit the filename of the video, or retain the default filename.
   - **Save to**: Specify the location of the saved video.

   You can then proceed to click Export, or you can choose to tweak the advanced settings.

   **Note:**
   
   The advanced settings default to the best settings based on the type of video and destination. You usually do not have to modify these settings, unless you have a specific video requirement.

   **Preset**: The default preset on all platforms is Automatic where Resolution and Frame Rate are set to Automatic, Audio Channels set to Stereo, and Quality is High. However, you can select any preset from the drop-down list based on the nature of your video and your eventual publish destination.

   You can also create a custom preset and save it. To create a custom preset, select the Custom icon in the Preset dropdown list, and then choose the required resolution, frame rate, audio, channel, and quality. You can also choose to import presets (.epr files) saved on your computer and use them instead of the Rush presets.

   **Resolution**: Various resolution options are available depending on the type of video and publish destination.

   **Frame Rate**: Various frame rate options ranging from 29.97 fps to 60 fps are available.

   **Audio Channels**: You can choose between mono, stereo, or no audio options.

   **Quality**: Set the quality of the video. High-quality videos take up more hard drive space.

3. Click Render Videos.

   Premiere Rush creates preview renders (cached video files on your hard drive) that allow you to play back your edit in real time if playback is not smooth.
Share your video on your YouTube channel

You can sign in to YouTube from Rush and directly share your video on your YouTube channel.

1. Click the Share button in the toolbar, and then choose YouTube.
2. Sign in to YouTube in case you are not signed in already.

3. In the Settings dialog box, set the following options:
   - **Title:** Add a title to your video.
   - **Description:** Help viewers understand more about the video by adding a description. This description displays at the bottom of the video after it is published live on YouTube.
   - **Tags:** Add tags to your video. Tags allow other YouTube users to see your video by linking common words associated with your video. Other videos with similar tags are often grouped in the sidebar on YouTube.
   - **Privacy when shared:** Select one of the options available: Public, Unlisted, or Private. Public videos can be searched for and viewed by anyone. Unlisted videos are only accessible to people who know the video link. Private videos are unlisted and only viewers whom you designate can view them. These users must have a Google account to access the video.
   - **Category:** Select a video category from the drop-down list.
   - **PlayList:** Choose a PlayList from the drop-down list.
   - **Schedule:** Select this check box if you want to schedule the video’s publish time. Then select the publish time from the date and time picker.
   - **Keep a copy of this file:** Select this option if you want a copy of the video saved on your computer. After selecting this option, navigate to the folder where you want to save the file.
You can then choose to set the following advanced settings, or leave them at the default value that are generally the best settings.

**Preset:** The default preset is *Match Sequence* where **Resolution** and **Frame Rate** are set to *Same as Sequence*, **Audio Channels** is set to *Stereo*, and **Quality** is *High*. However, you can select any preset from the drop-down list.

You can also create a custom preset and save it for later reuse by selecting the Custom icon in the Preset drop-down list, and then choosing the required resolution, frame rate, audio, channel, and quality. You can also choose to import presets (.epr files) saved on your computer and use them instead of the Rush presets.

**Resolution:** Various resolution options are available depending on the type of video and publish destination.

**Frame Rate:** Various frame rate options ranging from 29.97 fps to 60 fps are available.

**Audio Channels:** You can choose between mono, stereo, or no audio options.

**Quality:** Set the quality of the video. Viewers with low-bandwidth face difficulty streaming high-quality videos.

4 In the Preview: Device Version window, you can play and preview the video to see how it appears in YouTube.

You can also set the following options:

**Set Current Frame:** As you play the video in the Preview window, you can click **Set Current Frame** to set that particular frame as your video thumbnail. This video thumbnail is what viewers see when they are browsing YouTube. Make sure that the frame you select is one that catches a viewer's attention.

**Add your own Thumbnail:** You can also choose to pick a custom thumbnail. Click **Add your own Thumbnail** and browse to select a preferred image.

5 Click **Render Videos**.

Premiere Rush creates preview renders (cached video files on your hard drive) that allow you to play back your edit in real time if playback is not smooth.

6 After Premiere Rush completes rendering successfully, your video is ready to be published on YouTube. Click **Publish**. Rush publishes the video to YouTube, and notifies you when done.
Share your video on your Facebook feed

You can directly export your video to Facebook. You can only share a video on Facebook if you have an account associated with a Facebook page.

1. Click the Share button in the toolbar, and then choose Facebook.
2. Sign in to Facebook in case you are not signed in already.

3. In the Settings dialog box, set the following options:
   - **Pages**: Select the Facebook page associated with your account.
Title: Add a title to your video.

Description: Help viewers understand more about the video by adding a description. This description displays at the bottom of the video after it is published.

Keep a copy of this file: Select this option if you want a copy of the video saved on your computer. After selecting this option, navigate to the folder where you want to save the file.

You can then choose to set the following advanced settings, or leave them at the default value that are generally the best settings.

Preset: The default preset is Match Sequence where Resolution and Frame Rate are set to Same as Sequence, Audio Channels is set to Stereo, Quality is High. However, you can select any preset from the drop-down list.

You can also create a custom preset and save it for later reuse by selecting the Custom icon in the Preset drop-down list, and then choosing the required resolution, frame rate, audio, channel, and quality. You can also choose to import presets (.epr files) saved on your computer and use them instead of the Rush presets.

Resolution: Various resolution options are available depending on the type of video and publish destination.

Frame Rate: Various frame rate options ranging from 29.97 fps to 60 fps are available.

Audio Channels: You can choose between mono, stereo, or no audio options.

Quality: Set the quality of the video. Viewers with low-bandwidth face difficulty streaming high-quality videos.

4 In the Preview: Device Version window, you can play and preview the video to see how it appears in Facebook. You can also set the following options:

Set Current Frame: As you play the video in the Preview window, you can click Set Current Frame to set that particular frame as your video thumbnail. This video thumbnail is what viewers see when they are scrolling down their feed. Make sure that the frame you select is one that catches a viewer’s attention.

Add your own Thumbnail: You can also choose to pick a custom thumbnail. Click Add your own Thumbnail and browse to select a preferred image.

5 Click Render Videos.

Premiere Rush creates preview renders (cached video files on your hard drive) that allow you to play back your edit in real time if playback is not smooth.

6 After Premiere Rush completes rendering successfully, your video is ready to be published on Facebook. Click Publish. Rush publishes the video to Facebook, and notifies you when done.
Export Video to Instagram

To export your video to Instagram, save the file on your device, log in to your Instagram account, and share the video from the Instagram app on your iOS device.

1. Click the Share button in the toolbar, and choose Instagram.
2. In the Settings dialog box, set the following options:

   - **Export Location:** Select the folder where you want to export the file.
   - **Preset:** The default preset is Automatic where Resolution and Frame Rate are set to Automatic, Audio Channels set to Stereo, and Quality is High. However, you can select any preset from the drop-down list.

   You can also create a custom preset and save it for later reuse by selecting the Custom icon in the Preset drop-down list, and then choosing the required resolution, frame rate, audio, channel, and quality. You can also choose to import presets (.epr files) saved on your computer and use them instead of the Rush presets.

   - **Resolution:** Various resolution options are available depending on the type of video and publish destination.
   - **Frame Rate:** Various frame rate options ranging from 29.97 fps to 60 fps are available.
   - **Audio Channels:** Choose between Mono, Stereo, or No Audio options.
   - **Quality:** Choose between High, Medium, or Low quality.
3 Play and preview the video to see how it appears on Instagram.

4 Click **Render**. Once you click **Render**, the video gets saved to your device. Then, click **Done**.
5 Log in to your Instagram account, locate, and share the video.

Export video to Behance

You can directly export your videos to Behance.

1 Sign in to Behance in case you are not signed in already.

2 In the Settings dialog box, set the following options:
   
   **Description:** Help viewers understand more about the video by adding a description. This description displays at the bottom of the video after it is published live on Behance.

   **Tags:** Add suitable tags to your video. Tags allow other users find your video by linking common words associated with your video.

   **Preset:** The default preset is Automatic where Resolution and Frame Rate are set to Automatic, Audio Channels set to Stereo, and Quality is High. However, you can select any preset from the drop-down list.
   
   You can also create a custom preset and save it for later reuse by selecting the Custom icon in the Preset drop-down list, and then choosing the required resolution, frame rate, audio, channel, and quality. You can also choose to import presets (.epr files) saved on your computer and use them instead of the Rush presets.

   **Resolution:** Various resolution options are available depending on the type of video and publish destination.

   **Frame Rate:** Various frame rate options ranging from 29.97 fps to 60 fps are available.

   **Audio Channels:** Choose between Mono, Stereo, or No Audio options.

   **Quality:** Choose between High, Medium, or Low-quality options.
You can play and preview the video to see how it appears on Behance.

Click **Render**

Premiere Rush creates preview renders (cached video files on your hard drive) that allow you to play back your edit in real time if playback is not smooth.

After Premiere Rush completes rendering successfully, your video is ready to be published on Behance. Click **Publish**. Rush publishes the video to Behance, and notifies you when done.
Export video to Behance